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argomenti dell'esercitazione

in questa esercitazione si trattano:

5

>

realizzazione su FPGA dellidea di progetto proposta nella lezione 11
> interfaccia hardware del coprocessore

> coprocessore quale componente @sys

> sistema Nios IT con coprocessore e Performance Counter

%  driver software

test e misura delle prestazioni con il Monitor Program

% test con accelernzione bloccante

%  test con accelerazione non bloccante
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Flusso di lavoro del progetto

fasi principali di sviluppo:

V VvV VYV Y

>

descrizione in VHDL del coprocessore con interfaccia #Avalon MM

costruzione @sys di un sistema Nios IT con coprocessore e performance counter
mapping del sistema su FPGA e compilazione

stesura di script TCL per la generazione del driver software HAL

stesura dell'applicazione software per test e misura della prestazione, in due
versioni:

sequenziale: esecuzione bloccante del calcolo nel coprocessore
pipellhed : esecuzione non bloccante del calcolo nel coprocessore

compilazione ed esecuzione dell'applicazione mediante Monitor Program, per due
varianti di ciascuna versione: una con valore di default del livello di ottimizzazione,
l'altra con livello 0%

salvafaggio dei perFormance report e archiviazione del progetto
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interfaccia hardware del coprocessore

due sorgenti VHDL realizzano il coprocessore memorg-mapped:
delay collatz.vhd, output del traduttore fdlvhd della versione del sorgente Gezel

resentato nella seconda lezione, modificata come da terza esperienza di

>

Ezbom’torio
delay collatz interface.vhd, che incorpora unistanza del componente di calcolo e

S
accede ai Seguenﬁ Segr\ali del bus Avalon: clock, resetn, read, write, chipselect,

waitrequest, writedata, readdata
entrambi i sorgenti sono disponibili nella cartella vhdl dell'archivio allegato, nonché nella

cartella VHDL/code/e11 dell'area riservata di laboratorio
la cartella contiene anche std logic_arithext.vhd, necessario alla compilazione del

componente di calcolo, e delay collatz codesign.vhd, di cui si dira appresso
la consultazione del sorgente delay collatz interface.vhd mostra le relazioni tra i segnali

di 1/0 del componente di calcolo e i segnali all'interfaccia Avalon
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coprocessore quale componente Qsys (1)

la cartella codesign nell'archivio allegato é predisposta per ospitare lo sviluppo del progetto

dopo avervi copiato i file *.vhd dalla cartella vhdl, la costruzione del componente
rocede come nel tutorial visto nell'esercitazione EQ4, con le dovute

custom Qsys r

differenze del caso
creato il progetto delay collatz codesign, con omonima entita top-level, si procede alla

creazione del componente custom delay collatz interface
in particolare, non occorre dotarlo dellinterfaccia Avalon Conduit, poiché il

componente non usa periferiche esterne alla FPGA
la definizione del nuovo ’ripo di componente & mostrata in figura

File Templates Beta View
28| Block Symbol &2

Files 22| Parameters 22| Signals & Interfaces

Component Type
» About Component Type

[delay_colIat:_avalon_mterface

Name:
Display name: |delay_collatz_component
Version: [151 |
Group: [Dedicated Systems IP Cores
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coprocessore quale componente @sys (2)

si procede quindi all'assegnazione dei file YHDL che descrivono il componente e alla loro
analisi, come mostrato in figura

N.B. per questo progetto non occorre copiare i file per la simulazione

File Templates Beta View

ComponentType &2 | Block Symbol &3 | Files 22| Parameters 22| Signals & Interfaces
» AboutFiles

Synthesis Files
These files describe this component's implementation, and will be created when a Quartus Prime syni

The parameters and signals found in the top-level module will be used for this component's paramete

Output Path Source File Type
delay_collatz_avalon_interface.vhd |delay_collatz_avalon_interface.vhd [VHDL
delay_collatz.vhd delay_collatzvhd \VHDL
std_logic_arithext.vhd std_logic_arithextvhd VHDL

Add File... ’ Re e File H Analyze Synthesis Files H eate Synthesis File f

Top-level Module: ldeIay_collatz_avalon_interface \v‘

DMI — Corso di laurea magistrale in Informatica Copyleft @ 2020 Giuseppe Scollo

7dil6

coprocessore quale componente @sys (%)

infine, si conclude la definizione del nuovo ﬁ{)o di componente con la definizione delle sue
interfacce Avalon e la collocazione dei segnali nelle interfacce appropriate, come illustrato
in figura

File Templates Beta View

Component Type BlockSymbol 23 | Files 22| Parameters 3 | Signals & Inferfaces %
+ About Signals
= 4
ame [ [ = 1 o
|m=avalon_slave_0 = ern e — 2valon_siave 0 - | Resumentston
- chipsslect [1) eie Type tAvalon Memory Mapped Slave ‘v‘
- r2ad [1] =2 R R —— T
= readdata [32) ez Associated Clock ]?lock_smk ‘v\
-a waitrequest [1] warregue > [ctock reset |
e Associated Reset |clock_ress ) j"
D= writedata [32] wiedat Assignments Edit
|B=clock_reset 7o It}
- resetn [1] I|v|E
ana Address units lWORDS J
| m=clock_si el
[ D-clo—cm » Associated clock |clock_sink
B s e Associated reset [clock_reset
Bits per symbol 8
Burstcount units [wBéoé L
Explicit address span im{wﬂod
= Timing
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sistema Nios II con coprocessore e Performance Counter

Connections Name Description Export | Clock Base End | IRQ
B ck_0 |Clock Source |
(=g} cik_in (Clock Input ok |exported
D1 clk_in_reset |Reset Input resetn
— ck |Clock Output clk_0
ok reset |Reset Output
| B nios2_gsys_0 INios Il (Classic) Processor | | |
ck |Clock Input ck_0
reset_n |Reset Input (e
—— data_master |Avalon Memary Mapped Master (e
—T instruction_master |Avalon Memory Mapped Master (e
Vi d_irq |Interrupt Receiver e IRQ O IRQ 31—
— Jtag_debug_modul... [Reset Output (e
| jtag_debug_module |Avalon Memary Mapped Slave (e 0x0004_0800 0x0004_0f ff
custom_instruction... |Custom Instruction Master
B onchip_memory2_0 |On-Chip Memory (RAM or ROM)
okt (Clock input ck_0
st |Avalon Memary Mapped Slave [cik1] 0x0002_0000 0x0003_ffff
resett |Reset Input [clk1)
B delay_collatz_avalo... delay_collatz_component
clock_reset |Reset Input [clock_sink]
avalon_slave_0 |Avalon Memory Mapped Slave [clock_sink] 0x0004_1048 0x0004_104b
clock_sink Clock Input lck_0
B performance_count... Performance Counter Unit
ok [Clock Input ck_0
reset |Reset Input (e
control_slave |Avalon Memary Mapped Slave (e 0x0004_1000 0x0004_103f
B jtag_uart_0 JTAG UART
ck Clock Input iclk_0
reset |Reset Input e
avalon_jtag_slave  |Avalon Memory Mapped Slave (e 0x0004_1040 0x0004_1047
—— i IInterrupt Sender e |

System Contents &2 | (TG Address Map 22 | Interconnect Requirements 2%

unsaved Path: nios2_gsys_0

nios2_qsys_0.data_master nios2_qsys_0.instruction_master
nios2_gsys_0.jtag_debug_module |0x0004_0800 - 0x0004_0fff 0x0004_0800 - 0x0004_Offf
onchip_memory2_0.s1 0x0002 0000 - 0x0003 ffff 0x0002 0000 - 0x0003 ffff

delay_collatz_avalon_interface_0.... [0x0004_1048 - 0x0004 104b
performance_counter_0.control_sl../0x0004_1000 - 0x0004 103f
tag_uart_0.avalon_jtag_slave 0x0004 1040 - 0x0004 1047
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mapping su FPGA e compilazione
er la costruzione del sistema Nios 11 illustrato nelle figure precedenti pud essere utile la
consultazione del tutorial di introduzione a Qsys
con alcune differenze, e.q. la dimensione della memoria & di 128 K® in questo
caso, gli indirizzi di base sono tutti assegnati dal sistema ecc.
i passi finali per il mapping del sistema sulla FPGA sono i sequenti:
in (Psys:
%  salvare il sistema con il nome embedded system in File > Save As...
%  generare il suo codice VHDL mediante Generate > Generate HDL...
uscire da @sys, quindi in Quartus:
&  assegnare il file embedded system.qip (in embedded system/synthesis) al
progetto
%  importare gli assegnamenti dal file DE1_SoC.gsf nella cartella de1soc dell'archivio
allegato
“  File > Save Project
%  compilare delay collatz codesign.vhd
DMI — Corso di laurea magistrale in Informatica Copyleft & 2020 Giuseppe Scollo
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driver software

la cartella script nell'archivio allegato contiene due script TCL per la generazione del driver software nel BSP del
progetto
i due script differiscono solo per un comando, presente in uno di essi, che prescrive il livello 053 di
ottimizzazione invece del livello O1 di default
questi script vanno copiati nella cartella codesign/ip/delay collatz avalon_interface

nella stessa cartella, rispettivimente in HAL/inc e HAL/src, vanno copiati i sorgenti C
delay collatz avalon interface.h e delay collatz avalon interface.c del driver software contenuti nella
cartella src dell'archivio allegato

gli scrip’r TCL sono stati scritti in analogja allo scrip‘r TCL del driver software del Performance Counter, reperibile
nella distribuzione del software Quartus Prime Lite 16.1 al percorso
$SOPC KIT NIOSZ2/../ip/altera/sopc builder ip/altera avalon performance counter

similmente, i sorgenti C del driver software del coprocessore sono stati scritti in (piu limitata) analogia con i
sorgenti C del driver software dello stesso IP Core, nella cartella HAL al suddetto percorso
la motivazione per questo modo, forse poco ortodosso, di produzione del driver software sta nel duplice fatto che

S linterfaccia Avalon del componente custom non rientra in alcuna delle classi di modelli di dispositivi generici
HAL di cui ol Cap. 7 del manuale di sviluppo software per Nios II Classic

@,  come pure non Vi rientra quella del Performance Counter Unit IP Core ...
a cui si aggiunge un discreto grado di analogia operativa dei due componenti

tuttavia si raccomanda la consultazione del Cap. 7 del suddetto manuale, per acquisire una migliore
comprensione della struttura e del contenuto del driver software
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programmi di test e misura delle prestazioni (1)

la cartella src nell'archivio allegato contiene i programmi in questione, da copiare nelle
cartelle di creazione dei progetti di test e misura delle prestazioni mediante il Monitor
Program, come seque:
% delay collatz sequential timing.c in codesign/amp s e in codesign/amp s 03
% delay collatz pipelined timing.c in codesign/amp p e in codesign/amp p 03
i parametri di creazione dei progetti sono indicati nel file allegato
CodesignMonitorNotes.txt
occorre alimentare la DE1-50C e collegarla al PC perché la creazione di ciascun progetto si
possa concludere con la programmazione della FPGA
differenze principali tra il sorgente dell'esercitazione E10 e lattuale versione sequenziale:
@ direttive #include e #define relative al componente custom
% sostituzione dellinput da dispositivo switches con una costante

%  rimpiazzamento del corpo della funzione delay collatz con due istruzioni del
driver software del componente custom
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Programmi di test e misura delle prestazioni 2

la versione p felmed del programma presenta differenze molto pit marcate rispetto al
programma dell'esercitazione E10:
si rende non bloccante |'interazione con lhardware custom sostituendo la
chiamata della funzione delay collatz con un inlining del suo corpo, dove perd
si ricolloca fra le due istruzioni, rispettivamente di avvio del calcoro hardware e
di lettura del risultato, il calcolo in software del punto di inizio della traiettoria
successiva

il meccanismo di sincronizzazione & molto sempllce grazie a proprieta del componente
custom e del segnale waitrequest del protocollo Avalon MM:
S per traiettorie di durata pia breve del calcolo software, il componente custom
mantiene il risultato nel registro interno e attende il comando di lettura
> per traiettorie di durata pia lunga del calcolo software, il comando di lettura
viene tenuto in attesa allinterfaccia Avalon mediante il segnale waitrequest
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test con accelerazione bloccante

la compilazione, caricamento sulla FPGA ed esecuzione del programma
delay collatz sequential timing.c, nei due progetti codesign/amp s e codesign/amp s 03
produce i Performance Counter Report in figura

la notevole riduzione del tempo di esecuzione della sezione delay collatz nella seconda
variante si spiega con Uinlining della funzione nella compilazione 0%

Terminal Terminal

--Performance Counter Report-- --Performance Counter Report--

Total Time: 0.499495 seconds (24974733 clock- cycles) Total Time: 0.346551 seconds (17327539 clock- cycles)

B R R Homen R e L PP + R e e et PP +
| Section | % | Time (sec)l Time (clocks)|0ccurrences| | Section | % | Time (sec)l Time (clocks)lOccurrencesI
e R e TP e Homn e T
Itra]ect start | 38| 0. 19005| 9502720| 65536| Itra]ect start | 49.5]| 0. 17170| 8585216| 65536|
--------------- e e s P PP e e e TR
Idelay collatz | 44. 4| 0.22162| 11081057| 65536| Idelay collatz | 35.7| 0.12373| 6186326 65536|
--------------- B e e e e B e e e e s

uno 5peed-up di un ordine di grandezza, rispetto al calcolo software nell'esercitazione E10,
risulta dai dati di prestazione in quel caso, con gli stessi livelli di ottimizzazione

Terminal Terminal

--Performance Counter Report-- --Performance Counter Report--

Total Time: 7.52118 seconds (3760589‘15 clock- cycles) Total Time: 4.55965 seconds (227982443 clock- cycles)

Foommmmmmee e +----- B Sttt st titots sttt + L R e S SR aatd Xl S et DL ety S L D +
| Section | % | Time (sec)l Time (clocks)I0ccurrence5I | Section | % | Time (sec)l Time (clocks)lOccurrencesI

L T Hemee- s abe LI ILLL Fooccececreconax foecoreccen + Fommmm s e Hocmoe R R T Fommeeeen- +
Itra]ect start | 2.53| 0.19005| 9502720| 65536I |traject_start | 3.77| 0.17170]| 8585216| 65536|
--------------- B i e Al R s St e e L E LT
Idelay collatz | 96.3| 7.24331] 362165262I 65536I |delay_collatz | 95.1| 4.33682| 216841223| 65536|
--------------- R A s SR St e e e e
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test con accelerazione non bloccante

é lecito attendersi un ulteriore guadagno di pres‘razione dall'esecuzione non
bloccante del calcolo nel componente hardware custom

dai Performance Counter Report che sequono, a confronto con i dati analoghi
della realizzazione con tutto il calcolo in software, risulta uno speed-up 21x con
ottimizzazione di default 01 e 1bx con ottimizzazione 0%; i corrispondenti valori
dello speed-up con accelerazione bloccante sono 15x con 01 e 15x con 0%

N.B. lo speed-up & calcolato sui valori del tempo totale; i dati di sezione sono
meno significativi con accelerazione non bloccante poiché le sequenze di esecuzione
delle due sezioni sono parallele nel tempo

Terminal

Terminal

--Performance Counter Report--

Total Time: 0.359145 seconds (17957243 clock-cycles)

--Performance Counter Report--
Total Time: 0.285762 seconds (14288114 clock-cycles)

rmmmmmeman Heme o drmmmememeaaas o + e emeen EEEEEEEE e  RREEEEREE .
| Section | % | Time (sec)| Time (clocks)|Occurrences| | Section | % | Time (sec)| Time (clocks)|Occurrences|
L 4omn R ERREEEEEE oo R EREEEEEE + L omnen oo drmmmmmmmemeaa  RREEEEEEE +
|traject_start | 52.9| 0.19005| 65536 |traject_start | 60.1| 0.17170]| 8585216 65536|
L e R TR e TP +  REEEEEEEE PR omeen REEEEEEE B R  ERREEEEEEE +
|delay_collatz | 86.5| 0.31065| 65536 |delay_collatz | 89.4| 0.25561| 12780693 65536|
Hommmmee e o dommmmmen Fommmmee e Hommmm e - B Hommm B B dommm e +
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riferimenti

materiali utili per l'esperienza di laboratorio proposta:

archivio con file sorgenti per la riproduzione del progetto

Awlon® Interface Specifications, Ch. 1-5

MNL-AVABUSREF, Intel Corp., 2014.10.08

Making CPS_yS Componem‘s - For Quartus Prime 10.1

Intel Corp. - FPGA University Program, November 2010

Introduction to the @Psys System Integration Tool - For Quartus Prime 16.1
Intel Corp. - FPGA University Program, November 2016

Nios IT Classic Software Developer's Handpook, Ch. 7

NIISV2, Altera, Intel Corp., 2015.05.14

Intel FPGA Monitor Program Tutorial for Nios 1T - For Quartus Prime 16.1
Intel Corp. - FPGA University Program, November 2010

15di 16

DMI — Corso di laurea magistrale in Informatica

Copyleft @ 2020 Giuseppe Scollo

16 di 16



